FLORIDA DEPARTMENT OF EDUCATION
Request for Proposal (RFP) for Discretionary, Competitive Projects

Bureau / Office
Independent Education and Parental Choice (IEPC)

Program Name

Interdistrict Agreements for Expanding School Choice through Voluntary Public School Choice
(VPSC) Models

Specific Funding Authority(ies)

Elementary & Secondary Education Act of 1965, as amended, Title V, Part B, Subpart 3; 20
U.S.C. 7225-7225¢g

CFDA/SUBPROGRAM: 84.316A

Funding Purpose

The Interdistrict Agreements for Expanding School Choice through Voluntary Public School
Choice (VPSC) Models aim to strengthen the availability, accessibility, and equity of educational
options for parents to secure a high quality education for their children. The purpose of the
program, with particular emphasis at the secondary level, is to implement interdistrict and/or
multi-interdistrict agreement models among partnering school districts to create and/or enhance
existing transfer agreements, thereby increasing public school choice options by expanding
access to K-12 school choice programs. Partnership agreements should substantially impact
students in lower-performing schools.

Funding Priorities

Funding priorities include interdistrict and/or multi-interdistrict agreements that use capacity-
building enhancement methods to expand access to K-12 school choice programs.
Enhancement methods may include, but not be limited to, the following:

1. Replication of school choice programs such as, but not limited to, career academies,
magnets, charter schools, International Baccalaureate programs, and/or virtual
education.

Implementation of school choice feeder patterns.
Improvement of transportation.
Interdistrict tuition transfers.

Any combination of these strategies or methods based on identified needs of the targeted
student populations.
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Target Population(s)
Students attending grade K-12 public schools wishing to use public school choice options to
transfer to higher quality educational programs.

Eligible Applicant(s)
Collaborating Partnerships among Florida Public School Districts

One application per proposed interdistrict and/or multi-interdistrict agreement model shall be
submitted with appropriate signatures of all partnering districts. Partnerships must be
exclusively between separate school board districts. A signed Partnering Districts’ Application
Certification by all collaborating partners must be included with the application, but does not
impact the page limit (Attachment A).

Application Due Date

April 14, 2008
The due date refers to the date of receipt in the Office of Grants Management.
Facsimile and e-mail submissions are not acceptable.

Total Funding Amount / Approximate Number of Awards

Approximately $5,100,000 is available within the five-year VPSC program period to support the
development and implementation of the interdistrict agreement models. Initial funding during
the first budget period of the five-year VPSC program will consist of $743,500. A minimum of
$100,000 to a maximum of $170,000 is expected to be awarded during the first budget period
for each approved interdistrict and/or multi-interdistrict agreement model.

The number of awards and the award amount will be based on the final U.S. Department of
Education (USDOE) award notification and number of high-quality proposals submitted to the
Florida Department of Education (FDOE) that are eligible for funding consideration. The FDOE
desires to award a minimum of three grant awards to partnering school districts.

To be eligible to receive continual funding in the multi-year project, participating districts must:

1. Submit an annual Request for Application (RFA).

2. Submit any documentation and data bi-annually as required by the FDOE or USDOE.

3. Agree to participate in statewide technical assistance training and evaluation activities to
be scheduled and conducted by the FDOE.

4. Comply with applicable Federal and State statutory and regulatory requirements.

5. Submit the annual evaluation at least 60 days prior to the end of the project performance
periods.

Matching Requirement
None
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Budget / Program Performance Period

Budget Period:

For Federal Programs the project effective date will be the date that the application is received
within the Florida Department of Education (FDOE) in substantially approvable form, or the
effective date of the Federal Award Notification, whichever is later.

Program Performance Period:

The performance period regarding this application shall be known as the planning and program
design period, coinciding with the budget period. Based on a multi-year project, the
performance period includes five program performance periods.

Contact Persons

Program Contact: Grants Management Contact:

Yolanda Miranda-Hill Margaret White

VPSC Program Manager Office of Grants Management

850-245-9077 850-245-0716

yolanda.miranda-hill@fldoe.org margaret.white @fldoe.org
Assurances

The Florida Department of Education developed and implemented a document entitled General
Terms, Assurances and Conditions for Participation in Federal and State Programs, to comply
with:
= 34 CFR 76.301 of the Education Department General Administration Regulations
(EDGAR) which requires Local Educational Agencies (LEAS) to submit a common
assurance for participation in federal programs funded by the U.S. Department of
Education (USDOE);
= Applicable regulations of other Federal agencies; and
= State regulations and laws pertaining to the expenditure of state funds.

In order to receive funding, applicants must have on file with the Florida Department of
Education, Office of the Comptroller, a signed statement by the agency head certifying applicant
adherence to these General Assurances for Participation in State or Federal Programs. The
complete text may be found at: http://fldoe.org/comptroller/doc/gbsectiond.doc

School Districts, Community Colleges, Universities, and State Agencies
The certification of adherence, currently on file with the Department of Education Comptroller’s
Office, shall remain in effect indefinitely. The certification does not need to be resubmitted with
this application, unless a change occurs in federal or state law, or there are other changes in
circumstances affecting a term, assurance, or condition.
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Narrative Components / Scoring Criteria
- The Instructions describe what the applicant is to include in each Narrative Component.

- Following the Instructions, within each Narrative Component, are Criteria. The bulleted,
italicized statements are used by proposal reviewers to assess and score each
Narrative Component.

- The standard scoring Criteria are based on a 100 point scale, with a minimum score of
70 points required for an application to be considered eligible for funding.

1. Project Abstract or Summary FIXED REQUIREMENT

Instructions

Provide a brief one-page summary of the proposed interdistrict or multi-interdistrict
agreement model, naming partnering districts, goals, brief program design, and
significance (contribution and rationale) of impact on the targeted student population(s).
If the proposed project is an expansion of an existing interdistrict agreement, provide a
brief overview of the previous agreement and the basis for enhancement.

Criteria

e The proposed interdistrict or multi-interdistrict agreement model is described in a brief
summary, including general purpose, specific goals, brief program design, and
significance (contribution and rationale).

e The proposed project clearly aligns with the intended funding purpose and project
priorities.

2. Project Need 10 points

Instructions

Describe the need for the proposed interdistrict or multi-interdistrict agreement model

and provide supporting data as evidence. Explain how the need for the service(s) to be
provided or the activities to be carried out will benefit the final outcome(s) of the project.
Describe how the model will meet the learning needs of the targeted student population.

Criteria

e The need for the proposed interdistrict or multi-interdistrict agreement model is clear
and well justified with supporting data (student performance, demographic, etc.).

e The importance of the need for the services to be provided or the activities to be
carried out is apparent and clearly linked to the outcome(s) of the project.

e The proposed project focuses on services to be provided or otherwise addresses the
identified needs of the targeted population.

e Gaps or weaknesses in services are explained, including the nature and magnitude of
the gaps and/or weaknesses.
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3. Project Design and Implementation 35 points

Instructions

Name the partnering districts and the role for which each partner is responsible within the
proposed interdistrict or multi-interdistrict agreement model. Describe in detail the goals,
measurable objectives, methods, and timeline for the proposed project. Include an
outline of each objective and measurements on the VPSC Interdistrict Agreement Model
Objectives Chart (Attachment B). Estimate the number of students to be served and
describe why the students are included in the targeted population. Clarify the student
application process between partnering school districts. Explain the policy dictating
procedures if the proposed project is over-subscribed. Describe the level of instruction
that will be offered to participating students. Explain the coordinated transportation plan
between the partnering districts and/or describe the transportation arrangements for
participating students. Describe how teachers involved in the interdistrict agreement
model will be identified and trained. Describe how the proposed project will include
collaborative efforts between districts School Choice office and the districts’ Title | office.

Criteria

e Partnering districts’ roles are clear and aligned within the proposed interdistrict or
multi-interdistrict agreement model.

e The goals, purpose, and outcomes are clearly specified and measurable.

e The objectives are measurable, quantitative, challenging, yet achievable, and address
all expected outcomes of the proposed project.

e The timelines are specific, realistic, and consistent with measurable objectives and
outcomes.

e Using the requested format, the outline of each objective adequately summarizes the
proposed project’s performance development and outcomes.

e The description and explanation of the targeted student population is clear.

e The design of the proposed project aligns with, and successfully addresses, the
needs of the target population.

e The description of the student application process between partnering school districts
is clear.

e The policy dictating the procedures should the proposed project be over-subscribed
has been addressed and is clear.

e The description of how teachers will be identified and trained is detailed and
demonstrates an understanding of the specific strengths and needs of each
partnering district.

e The collaboration between the districts’ School Choice Office and the districts’ Title |
office is clearly described and is likely to result in effective and ongoing coordination
and communications.

e The transportation plan is efficient and specifically addresses the needs of the
proposed model and of the targeted population.

e The methodology reflects up-to-date knowledge from research and best practices.
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4. Evaluation 15 points

Instructions

Describe the instruments and data collection methods, internal and external, for meeting
the goals, objectives, and outcomes of the proposed interdistrict or multi-interdistrict
agreement model. Describe the evaluation design, including both quantitative and
gualitative measures. Provide data collection activities and instrumentation designed to
effectively measure changes in participating students’ academic achievement. Explain
how the data is evaluated and utilized to support changes in expected outcomes.

Criteria

e The evaluation methods are thorough, feasible, and appropriately matched to meet
the goals, objectives, and outcomes of the proposed interdistrict or multi-interdistrict
agreement model.

e The evaluation design is clear and includes both quantitative and qualitative data
collection measures.

e The evaluation data collection activities and instrumentation, both internal and
external, are designed to effectively measure changes in student academic
achievement as a result of participation in the proposed project.

e The evaluation development and method(s) includes collaboration between partnering
districts in order to assess the significance of the proposed project’s impact on
students’ achievements.

e The explanation of how the data is evaluated and utilized to support changes in the
expected outcomes is clear and will effectively measure continual success of the
proposed project.

e The evaluation process includes summative information that will assess the value of
the proposed project’'s components and strategies.

5. Support for Strategic Imperatives FIXED REQUIREMENT

Instructions

Incorporate Strategic Imperative 5.0, Quality Choice Options, of the Florida State Board
of Education (SBE) Strategic Imperatives.

URL: http://www.fldoe.org/strategic%5Fplan/pdfs/2005-07 StratPlan.pdf

Additionally, describe how the proposed interdistrict or multi-interdistrict agreement model
will address the reading and math/science initiatives of the FDOE.

Just Read Florida

URL: http://www.justreadflorida.com/

Math / Science Initiative

URL: http://www.fldoestem.org/center13.aspx
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Criteria

e The applicant has included effective methods for incorporating strategic imperatives of
the State Board of Education, particularly Strategic Imperative 5.0, Quality Choice
Options.

e The proposed interdistrict or multi-interdistrict agreement model utilizes a
comprehensive plan for integrating pertinent aspects of the Just Read, Florida! and
the Math/Science initiatives.

6. Dissemination Plan 20 _points

Instructions

Describe the methods/strategies to disseminate and share information with the parents
and students in targeted populations regarding the proposed interdistrict or multi-
interdistrict agreement model. Clarify collaborative parent outreach efforts between
partnering districts. Provide strategies for employing community outreach efforts,
including the possibility of utilizing current and future Florida School Choice Parent
Resource Centers (PRC) to increase awareness of educational option offered through
the proposed project. A listing of current PRCs can be viewed at
http://www.schoolofed.nova.edu/choice/parent/resource _center.htm.

Criteria

e The applicant’s dissemination plan will use effective and realistic means to reach the
appropriate audiences, including the target population(s), the local community, and
other organized entities.

e The methods strategies used to share services provided by the partnering districts are
innovative.

e The dissemination plan reflects a thorough grasp of the proposed interdistrict or multi-
interdistrict agreement model and the positive impact on the targeted population(s).

e Dissemination plan includes community outreach efforts and, if applicable, possible
utilization of the Florida School Choice Parent Resource Centers (PRC).

7. Sustainability 5 points

Describe participating districts’ consideration of non-grant funds (to be determined at the
beginning of the final performance period) to assure the proposed interdistrict and/or
multi-interdistrict agreement model is sustainable after the five-year project period.
Indicate continuous level of services to be provided to the targeted student population
beyond the five-year project period. Provide anticipated sustainable efforts among the
partnering districts.

Criteria

e The proposed plan to generate non-grant funds for providing continuous level of
services to the targeted student population is explained and supports sustainable
efforts.
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e The anticipated sustainability strategies realistically support continuation of the
proposed interdistrict and/or multi-interdistrict agreement model’s ongoing efforts.

8. Budget 15 points

Instructions

Present a budget that reflects the goals and objectives with proposed costs of the initial
planning and program design period. The budget must be comprehensive, detailed, well-
justified, and support the goals, objectives, and activities/strategies outlined in the
proposal. The budget should name the Primary Fiscal Agency and detail funding
allocation among the partnering district(s). The budget must include, if applicable, the
shared costs of transportation for participating students among the partnering districts.
Estimated travel costs for two statewide technical assistance workshops and an annual
attendance to the VPSC conference are required. Include a projected multi-year
proposed budget of the estimated costs for the implementation periods as outlined on the
Projected VPSC Interdistrict Agreement Model Five-Year Budget Worksheet (Attachment
C).

Only item descriptions and total amounts for the initial Planning and Program
Design Period must be transferred onto the DOE 101 Budget Narrative Form.

Criteria

e The budget is thorough, specific, and supports the proposed interdistrict or multi-
interdistrict agreement model.

e The proposed project budget presents expenses that are allowable, realistic,
accurate, and clearly relate to and reflect project activities, objectives, and outcomes.

e The costs are reasonable in relation to the goals, objectives, design, and significance
of the proposed project.

e The costs are reasonable in relation to the size and needs of the targeted student
population and in relation to the expected outcomes and benefits.

e The required personnel, professional and technical services, for the proposed project
are clearly and adequately explained.

e Travel costs for participation of statewide technical assistance workshops and VPSC
conferences are reasonable and include the number of estimated participants for such
events.

e The justifications for expenditures are reasonable and clearly explained.

e Using the requested format, the projected multi-year outlined budget of the estimated
costs for the implementation periods visibly supports the goals, objectives, design,
and outcomes of the proposed project.

Method of Answering Frequently Asked Questions
Frequently asked questions will be posted by April 7, 2008 at the Office of Independent
Education and Parental Choice website at http://www.floridaschoolchoice.org/Information/vpscl/.
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Questions will not be answered by telephone or e-mail. Questions will not be addressed
after April 4, 2008.

Funding Method(s)

Federal Cash Advance (Public Entities Only) (C)

On-line reporting required monthly to record expenditures. Federal cash advances will be made
by state warrant or Electronic Funds Transfer (EFT) to a recipient for disbursements. For
federally funded projects, requests for federal cash advance must be made on the Electronic
Federal Cash Advance Request System. If at times it is determined that disbursements are
going to exceed the amount of cash on hand plus cash in transit, an on-line amendment can be
made prior to the due date of the next Federal Cash Advance distribution on the Electronic
Federal Cash Advance Request System.

Fiscal Requirements
Supporting documentation for expenditures is required for all funding methods. Examples of
such documentation include but are not limited to: payroll records, contracts, invoices with check
numbers verifying payment, and/or bank statements; all or any of which must be available upon
request.

Funded projects and any amendments are subject to the procedures outlined in the Project
Application and Amendment Procedures for Federal and State Programs (Green Book) and the
General Assurances for Participation in Federal and State Programs.

URL: http://www.fldoe.org/comptroller/gbook.asp

The project award notification (DOE 200) will indicate:

0 Project budget
o0 Program periods
o Timelines:
= Last date for receipt of proposed budget.
= Program amendments.
= Incurring expenditures and issuing purchase orders.
= Liquidating all obligations.
= Submitting final disbursement reports.

Project recipients do not have the authority to report disbursements before or after these
specified dates.

Allowable Expenses: Project funds must be used for activities that directly support the
accomplishment of the project purpose, priorities, and expected outcomes. All expenditures
must be consistent with applicable state and federal laws, regulations, and guidance.

Funding can be used to:
e Plan and design a public school choice program (during planning period).
e Carry out public information campaigns to inform parents and students about public
school choice opportunities.
e In years two through five of the project periods, funds can be used to make tuition
transfer payments to the public schools that students choose to attend.
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e Enhance capacity-building activities in high-demand public schools allowing them to
serve greater numbers of students.

e Pay other costs that are allowable and reasonably necessary to implement a public
school choice program that will directly impact the students including, but not limited to,
personnel, professional development, student services, instructional equipment,
laboratory equipment, supplies, simulation hardware and software, or other non-recurring
expenses associated with the development, implementation, and evaluation of a career
academy.

Unallowable Expenses: Project funds may not be used to supplant existing programs and/or
funding. Funds cannot be use for school construction.

Administrative Costs including Indirect Costs: For Federally funded projects, indirect costs
are capped at the applicant’s approved negotiated rate. No more than 5 percent of the funds
made available through the grant for any fiscal year may be used for administrative expenses.

Project Performance Accountability and Reporting Requirements
The Department’s program managers will track each project’s performance based on the
information provided in the Performance Expectation section, pages 18-29. Information in this
section is provided by the partnering districts based on the goals, objectives, and program
design of the proposed interdistrict and/or multi-interdistrict model.

Method of Review
A committee composed of state educational professionals will review and evaluate the proposed
Interdistrict Agreements for Expanding School Choice through Voluntary Public School Choice
(VPSC) Models. Each proposal will be read and reviewed by a minimum of five readers and
scored on each narrative component. The review committee will be selected to reflect a
balance of backgrounds, experience, race, ethnicities, and geographic locations within Florida.
Scores will be averaged, results discussed, priorities listed, and recommendations made to the
Commissioner of Education. FDOE staff will review recommended proposals for compliance
with the programmatic and fiscal policies of the project. The FDOE will allocate funds utilizing a
statewide competitive process for awarding projects to eligible recipients.

Proposals with a final score of less than 70 are not eligible for funding consideration.

Conditions for Acceptance / Substantially Approvable Form
The requirements listed below must be met for applications to be considered in Substantially
Approvable form and thus eligible for review:
e Application is received within DOE no later than the close of business on the due
date.
e Application includes required forms:
o DOE 100A Application Form bearing the original signature of the Superintendent
for the school district or the agency head for other agencies.
o DOE 101- Budget Narrative.
NOTE: Applications signed by officials other than the appropriate agency head
must have a letter signed by the agency head or documentation citing action of the
governing body delegating authority to the person to sign on behalf of said official.

DOE 905 10
REVISED December 2007




e Submission of the signed certification signifying compliance with the “General
Assurances for Participation in Federal and State Programs,” (if not already on file in the
DOE Comptroller’s Office).

Other Requirements

For Federal Programs - General Education Provisions Act (GEPA)

In accordance with the requirements of Section 427 of the GEPA Public Law 103-382, a current
fiscal year General Education Provisions Act (GEPA) plan is required. The applicant must
submit, with this application, a one page summary description of the plan proposed by the
District or other entity to ensure equitable access to, and participation of students, teachers, and
other program beneficiaries with special needs.

For details, refer to URL: http://www.ed.gov/fund/grant/apply/appforms/gepa427.pdf

For Program Office
e The applicant must submit, with this application the following forms:
o Partnering Districts’ Application Certification.
o VPSC Interdistrict Agreement Model Objectives Chart.
o Projected VPSC Interdistrict Agreement Model Five-Year Budget Worksheet.
e An assurance statement confirming partnering districts agreement to coordinate efforts
with the VPSC project manager and project’s third-party evaluator concerning reporting
format, data elements, and data benchmarks, is required.

Technical / Formatting and Other Application Submission Requirements

e Submit one application with original signatures and five copies of completed
application.

e Narrative responses must be:

0 Double-spaced, single-sided

0 12 point/Arial Font

0 1” Margins (both sides and top / bottom)
e No Bound Copies

e 25-page maximum for narrative response portion of the application package (does not
include required forms and letters or other required attachments)

Note: Additional pages exceeding the maximum 25 narrative response will be
removed and will not be reviewed.

e View Other Requirements section for a list of required forms that must be included with
the application.

Request for Proposals Training Sessions
Request for Proposals training sessions will be held to provide further explanation of the RFP
application process. Details related to the agenda, and schedule will be posted at the Office of
Independent Education and Parental Choice website:
http://www.floridaschoolchoice.org/Information/vpsc/ by March 17, 2008.
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Application must be submitted to:

Office of Grants Management
Florida Department of Education

325 W. Gaines Street, (Room 325)
Tallahassee, Florida 32399-0400
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ATTACHMENT A

Voluntary Public School Choice (VPSC) Interdistrict Transfer Agreement Models
PARTNERING DISTRICTS’ APPLICATION CERTIFICATION
Primary Fiscal Agency:

The filing of this application has been authorized by each District School Board listed below. Each
District Superintendent has been duly authorized to file this application and acts as the authorized
representative in connection with this application. The Primary Fiscal Agency is identified and is
indicated by the first signature listed below.

Certification is hereby given that all facts, figures, and representations made in the application are true
and correct, and are consistent with the statements of assurances signed and submitted previously by this
district.

District Signature of Superintendent
(Primary Fiscal Agency)

Certification is hereby given that all facts, figures, and representations made in the application are true
and correct, and are consistent with the statements of assurances signed and submitted previously by this
district.

District Signature of Superintendent

Certification is hereby given that all facts, figures, and representations made in the application are true
and correct, and are consistent with the statements of assurances signed and submitted previously by this
district,

District Signature of Superintendent

Certification is hereby given that all facts, figures, and representations made in the application are true
and correct, and are consistent with the statements of assurances signed and submitted previously by this
district,

District Signature of Superintendent

Date
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ATTACHMENT B

VPSC Interdistrict and/or Multi-Interdistrict Agreement Model

Goals, Measurable Objectives, Measurable Instruments, Activities, and Timeline Table Instructions

Proposal goals must have at least four broad goals.

Goals (Global Outcomes): program goals (e.g., ‘Improve Academic Achievement’) are very broad, realistic and are derived
for the needs assessment data. Goals must be numbered (i.e., ‘'1’, '2’, ‘3).

Measurable Objectives (Specific Outcomes): For EACH goal, the applicant must include specific, annual objectives that
are measurable, quantitative, challenging (yet achievable), and that can be measured at the end of the project year. Within
each measurable objective, applicants must identify anticipated measurements that will be used to assess project
performance of the stated objective. Objectives must be numbered (i.e., ‘1.1°, ‘1.2’, '2.1’, 2'2").

Activities and Timeframe: For EACH objective, applicants must include specific activities that will clearly allow the program
to progress towards and meet the standard objective(s) and that align to the activities described in the Project Design and
Implementation section of the Narrative Component. For each activity, the applicant must indicate the timeframe in which
each activity will be occurring (e.qg., ‘daily during the project year’, ‘monthly during the school year’, ‘during the second
implementation period’). Activities and timeframes must be identified using a letter system, where the letter will be used to
identify all activities and timeframes implemented to meet objectives (i.e., ‘a’, ‘b’, ‘Cc’).
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ATTACHMENT B

VPSC Interdistrict and/or Multi-Interdistrict Agreement Model

Goals, Measurable Objectives, Measurable Instruments, Activities, and Timeline Table

Goals Measurable Measurable Activities Timeline Table
Objectives Instruments
1) 1.1) 1.1) a) a)
b) b)
1.2) 1.2)
C) C)
d) d)
2) 2.1) 2.1) a) a)
b) b)
2.2) 2.2)
C) C)
d) d)

Each applicant will develop a table based on the needs of the interdistrict and/or multi-interdistrict agreement
model and student targeted population.
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ATTACHMENT C

VPSC Interdistrict and/or Multi-Interdistrict Agreement Model
Instructions for Projected Five-Year Budget Worksheet

This form is designed to assist applicants to project how federal funds will be used for planning, program design, and
implementation across a maximum of five years. Projected expenditures must be consistent with the intent of the program.
Complete descriptions of the categories of proposed expenditures can be found in the Financial and Program Cost
Accounting and Reporting for Florida Schools Manual (Red Book). A copy of this manual can be accessed at
http://www.firn.edu/doe/fefp/redtoc.htm.

Please be aware that:

e The first budget period is intended primarily for initial planning and program design.

e The second budget period is intended for continual planning and program design, however should include costs for initial
implementation.

e The third and fourth budget periods are intended for implementation.

e The final budget period is intended for continual implementation and preparation for sustainability.

Please be aware of timeline:

e The total amount of time allowed for planning and program design may not exceed 16 months.

Only item descriptions and total amounts for the initial Planning and Program Design Period must be transferred
onto the DOE 101 Budget Narrative Form.

The amounts projected for year 2-5 budget periods are estimates only and may be revised at the time those funds are
requested (through submission of the appropriate documentation as specified on future Request for Application).
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ATTACHMENT C
VPSC Interdistrict and/or Multi-Interdistrict Agreement Model

for Projected Five-Year Budget Worksheet

T October 1, 2009 October 1, 2010 October 1, 2011
Five-Year Awgg?e'\iﬁ:g'jgﬂon OCtO.PﬁrLibf]OOS Throggh Throggh Throggh
Projected Budget | september 30. 2008 September 30, September 30, September 30,

eptember 30, September 30, 2009 2010 2011 2012
First Budget Third Budget Fourth Budget Final-Year
Category of Period Second Budget Period Period Period Budget Period
Proposed P po— oo
Expenditures Pl & Planning & e Implementation | Implementation | Implementation
Program Design | Program Design | Implementation
Deefgélr]pc::?unrgf Estimated Cost Estimated Cost | Estimated Cost | Estimated Cost | Estimated Cost | Estimated Cost
Total*

*The total for the first budget period must match the total on the DOE 101, Budget Narrative Form.
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APPLICANT INSTRUCTIONS: PERFORMANCE ACCOUNTABILITY

The Florida Department of Education has a standardized process for preparing proposals / applications for discretionary funds. This
section of the RFP, Project Performance Accountability, is to assure proper accountability in the use of federal and state funds.
Using the following forms and instructions, applicants are to select Project Performance data for each proposed project. If funded,
the data is entered into the DOE web-based Grants Management System; data entry continues through the life of the grant. The
Department’s program managers will track each project’s performance based on the information provided.

This information will:

v' Provide a centralized capability for retrieving information about various discretionary projects awarded by the Department.

v' Assist policy-makers and managers in monitoring discretionary funds and the impact they are having.

v" Provide baseline information that can be used in assessing the alignment of funding to goals and strategic imperatives and in
allocating available funding to priority needs.

v Facilitate effective project monitoring.

Types of project performance have been organized into four categories. These are:

v' Deliverables: Category Includes: Documents such as manuals, reports, videos, CD ROMs, training materials, brochures, and
any other tangible product to be developed by the project.

v' Training, Technical Assistance, and Dissemination: Category Includes: All training and technical assistance (TA) activities
whether provided onsite, through distance learning media, conferences, workshops, or other delivery strategies.

v' Student Performance: Category Includes: Any measure that is specific to student performance (e.g., test scores, attendance,
behavior, award of diplomas, certificates, etc.). “Students” may include pre-k, K-12, and adult learners as well as parents.

v' Service Delivery: Category Includes: Delivery of intended services to target population (e.g., adult literacy services, child find
services, student evaluation services, etc.).

For each type of performance for which a project will be held accountable, the applicant must complete the information specified in
the attached forms. Use only those forms and types of performance applicable to the project. Instructions are provided for the
completion of each form.

Selected projects are required to obtain independent, formal, third-party evaluations. Other projects elect to obtain such evaluations.
If the proposal or application includes a required or optional third-party evaluation, a form and instructions for describing the proposal
evaluation are provided.
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Deliverables: Manuals, reports, videos, CD ROMs, training materials, brochures, and any other tangible
product to be developed by the project.

(1) For each deliverable in the proposed project, enter in Column (1), the name of the deliverable and a brief description. Use only the following
list to identify each deliverable. Indicate the purpose of the deliverable, the target audience, and the type of content to be provided in the
deliverable. For example, “Brochure for parents of retained students explaining options for assistance.” Include any required reports in this
section.

(1) Name of Deliverable and Brief Description

= Announcement = Lesson Plans = Survey

» Brochure = Manual » Teacher’'s Guides

= CD Rom = Needs Assessment = Technical Assistance Paper
= Curriculum = Newsletter » Training Materials — Handout
» Database = Policy Paper » Training Materials — Presentation
= Database Analysis = Poster (PowerPoint)

= Display = Public Service Announcement = Training Modules - Online

= DVD = Report * Video

= Evaluation Instrument = Report Format = Website

= Guidelines = Screening Device = Workbook

= Instructional Materials = Software = Other

(2) For each deliverable identified in Column (1), specify all of the proposed standards that should be used to determine whether the deliverable
meets the expectations for the project. The standards should be selected from the following list and any additional detail appropriate to each
standard should be provided. For example, if one of the standards is “Meets technical specifications,” the descriptions should outline the
proposed technical standards.

(2) Standard(s) for Acceptance

= ADA Compliant = Format Consistent with Content and » Review by DOE Staff
= Appropriate for Duplication Intended Audience » Review by Other Entity
= Appropriately Organized = Grammatically Correct » Sufficient Copies Provided
= Attractive = Includes Copyright and Funding » Translated into Appropriate Languages
= Content Accurate Information = User-Friendly
= Content Complete = Meets technical specifications = Other
» Design and Content Appropriate to = Peer Review

Intended Audience = Readability Level is Appropriate to

Audience

(3) In the third column, provide the date when the deliverable will be complete. If applicable, include interim dates for drafts, review, etc.

DOE 905
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DELIVERABLES FORM (Examples: Manuals, reports, videos, CD ROMs, training materials, brochures, and any other tangible

product to be developed by the project.)

(1) Name of Deliverable and Brief Description

(2) Standard(s) for Acceptance

(3) Due Date(s)

DOE 905
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Training, Technical Assistance, and Dissemination: All training and technical assistance (TA) activities
whether provided onsite, through distance learning media, conferences, workshops, or other delivery
strategies

(1) For each training, technical assistance or dissemination activity to be completed by the project, enter in Column (1), the name of the activity
and provide a brief description. The name should be identified from the following list. The description should indicate the purpose of the activity,
including the target audience and should indicate the type of content to be provided. For example, “Training for third grade teachers of reading in
use of multiple instructional strategies.”

(1) Name of Activity and Brief Description

= Coaching = Distribution of Media (Software, Videos, = One-On-One Training
= Conference CD ROMs, etc.)Distribution of Printed = On-Site Technical Assistance
= Coursework at Institutions of Higher Material » Pre-service Training
Education = Exhibits = Seminars
= Dissemination though the Media = Follow-up to Training Activities = Telephone Technical Assistance
= Dissemination Through Internet = In-service Training = Workshop(s)
» Distance Learning = Mentoring = Other

(2) For each activity identified in Column (1), specify all of the proposed standards that will be used to determine whether the activity meets the
expectations for the project. Select the standards from the following list and provide any additional detail appropriate to each standard. For
example, if one of the standards is “Participant Feedback Indicative of Usefulness,” the descriptions should outline how participant feedback will
be gathered and assessed.

(2) Quantity and Quality Standards for Acceptance

= Appropriately Organized = Use of Consultants = Participant Feedback Indicative of
= Content Accurate = Follow-up Data Indicative of Effectiveness Usefulness
= Content Complete Format Consistent with Content and » Replicable
= Delivery Appropriate to Content and Intended Audience = User-Friendly
Audience = Grammatically Correct = Other
» Design and Content Appropriate to = Meets Technical Specifications

Intended Audience
(3) Provide in Column (3), the information / materials which will be provided (or otherwise available) to document the performance of the project.
(3) Method of Documentation

= Agreements = NRS Report = Self-Reporting

= Analysis of Requests and Responses = Observation by DOE Staff = Sign-in Sheets

» Anecdotal Data = Participant Competency Evaluations = Travel Itineraries

= Contracts = Participant Feedback Summaries = Verification of Dissemination to Target
= Evaluation Summaries = Peer Review Audiences

= List of Participants = Purchase Orders = Other

(4) In the fourth column provide the critical timelines for completion of each activity (taking into consideration announcements of training
availability, delivery of training, completion of follow-up, etc.).
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TRAINING, TECHNICAL ASSISTANCE, AND DISSEMINATION FORM (All training and technical assistance (TA) activities whether
provided onsite, through distance learning media, conferences, workshops, or other delivery strategies.)

(1) Name of Activity and Brief (2) Quantity and Quality (4) Critical
Description Standards for Acceptance (3) Method of Documentation Timelines
DOE 905 22
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STUDENT PERFORMANCE: Any measure that is specific to student performance; e.g., test scores,
attendance, behavior, award of diplomas, certificates, etc. Students may include pre-k, K-12, and adult
learners

(1) For each type of student performance to be impacted by the project, enter in Column (1), the name of the performance from the following list
and provide a brief description. The description should describe the student population and provide detail about the expected student
performance. For example, “Academic Achievement — Reading: Low-performing 3" grade students in Smith Elementary School will increase by
1 level on the FCAT.”

(1) Name of Performance and Brief Description

= Academic Achievement — Language Arts = Diploma » Participation in Assessment

= Academic Achievement — Math Enroliments » Participation in Least Restrictive

» Academic Achievement — Reading GED Environment (LRE)

= Academic Achievement — Science High School Credential » Placements, Retention, Completions
» Academic Achievement — Social Studies Job Placement (postsecondary JOBS)

» Academic Achievement — Writing Job Retention » Postsecondary Education Placement

= Achievement — Arts Improvement in Behavior » Postsecondary Education Completion
= Achievement — Other Increased Self-Sufficiency Through Use » Program Completion

= Achievement — Vocational Education of Technology » Promotion to Next Grade

= Attendance = Literacy Completion Points » Satisfactory Completion of Coursework
= Award of Certificate = Non-Traditional Enroliments = Secondary Credential

» Career Advancement Retention = Occupational Completion Points » State-Adopted Assessment

» Decrease in Disciplinary Actions = Parental Involvement in Education of » Workplace Readiness Completion

» Decrease in Drop-out Rate Dependent Children = Other

» Decrease in Suspensions / Expulsions = Parental Involvement in Literacy Activities

of Dependent Children

(2) For each student identified in Column (1), specify all of the proposed standards from the following list that should be used to determine
whether the performance meets the expectations for the project. Any additional detail appropriate to each standard should be provided. For
example, if one of the standards is “Graduation Data,” the description should outline how the data will be gathered and what level of graduation
rate is expected.

(2) Method of Evaluating Performance

» Anecdotal Data = Graduation Data » Progress Monitoring
= AYP Determination = Observation * Promotion Data
= Disciplinary Referrals = Participation Records = School Grades
» FCAT = Placement Data » Standardized Tests
» GED Data = Portfolios = Suspension / Expulsion Data
= Other
DOE 905 23
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STUDENT PERFORMANCE (continued)

(3) Provide in Column 3, the information / materials which will be provided (or otherwise available) to document the performance of the project.

(3) Method of DOE Verification

= Agreements = NRS Report = Self-Reporting

= Analysis of Requests and Responses = Observation by DOE Staff = Sign-in Sheets

= Anecdotal Data = Participant Competency Evaluations = Travel Itineraries

= Contracts = Participant Feedback Summaries = Verification of Dissemination to Target
= Evaluation Summaries = Peer Review Audiences

= List of Participants = Purchase Orders = Other

(4) In the fourth column, provide the critical timelines for completion of each activity taking into consideration announcements of training
availability, delivery of training, completion of follow-up, etc.
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STUDENT PERFORMANCE FORM (Any measure that is specific to student performance; e.g., test scores,

attendance, behavior, award of diplomas, certificates, etc. Students may include pre-k, K-12, and adult
learners.)

(1) Name of Performance and Brief (4) Timelines for
Description (2) Method of Evaluating Performance (3) Method of DOE Verification Data Collection
DOE 905 25
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SERVICE DELIVERY: Delivery of intended services to target population; e.g., adult literacy services, child
find services, student evaluation services, etc.

(1) For each type of service to be delivered by the project, enter in Column (1), the name of the performance from the following list and provide a
brief description. Describe the service and provide detailed information about the nature of the service to be delivered. For example,
“Mentoring—The project will provide trained adult mentors to work at least once per week with elementary students who have scored Level | or II
on the FCAT in reading or math.”

(1) Name of Service and Brief Description

= Adult Literacy Activities = Neighborhood Self-Sufficiency Through = Other

= Career, Technical Education Collaboration » Statewide Leadership Activities

= Interagency Collaboration = Participation in Defined Program (e.g., = Student Evaluation / Assessment
= Mentoring After-School)

= Referrals for Other Services

(2) For each service identified in Column (1), specify from the following list all of the proposed standards that will determine whether the
performance meets the expectations for the project. Any additional detail appropriate to each standard should be provided. For example, if one
of the standards is “Mentoring is appropriate to identified needs,” the description should specify of the identified needs and indicate of how the
project will determine that mentoring is appropriate.”

(2) Standard(s) for Acceptance

= Mentoring Is Appropriate to ldentified = Quantity of Evaluations / Assessments » Specified Agencies Collaborate
Needs Meet Established Minimums Quantity of » Students Evaluations / Assessments Are
» Participation Rate Meets Established Mentoring Meets Established Minimums Administered Appropriately
Minimums = Quantity of Service Meets Established = Units of Service Meet Established
» Quality of Service Meets Generally Minimums Minimums
Accepted Guidelines = Referrals Are Appropriate to Identified = Other
Needs

(3) Provide in Column (3), the information / materials which will be provided (or otherwise available) to document the performance of the project.

(3) Method of DOE Verification
= Agreements = Meeting Agendas » Purchase Orders
» Anecdotal Data = Meeting Minutes = Sign-in Sheets
= Attendance Records = NRS » State-Approved Assessments
Case Records = Observation by DOE Staff = Travel Itineraries
Contracts = Participant Feedback Summaries = Other
List of Participants

(4) Provide in Column (4), the critical timelines for service delivery including initiation and termination dates, for example.
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SERVICE DELIVERY FORM (Delivery of intended services to target population; e.g., adult literacy services, child find

services, student evaluation services, etc.)

(1) Name of Service and Brief
Description

(2) Standard(s) for Acceptance

(3) Method of DOE Verification

(4) Timeline for
Service Delivery
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FORMAL THIRD-PARTY EVALUATION: A formal evaluation conducted by a party not employed by the
fiscal agent either under contract with the project recipient or under the auspices of the DOE

If a formal third-party evaluation is required or proposed for this project the following information must be provided.

(1) In column (1), specify the scope of the evaluation using one or more of the descriptors provided below. Provide additional information
regarding the nature of the evaluation. For example, if the evaluation will cover only selected elements of the project, specify the elements to be
evaluated.

(1) Scope of Evaluation and Brief Description
= All Aspects of Project = Outcome Assessment = Selected Elements of Project
= Compliance Review = Process Review = Summative Evaluation
» Formative Evaluation

(2) In column (2) indicate the type of entity from the following list which will be conducting the third-party evaluation. Provide any additional
information which may be available about the entity to conduct the evaluation such as selection criteria or qualifications.

(2) Type of Entity Conducting Evaluation

» Board / Commission / Task Force = Governmental Agency = Institution of Higher Education
» Consultant Firm = Independent Entity Selected by Project » Selected Peer Reviewers
» DOE Funded Project = |Individual Consultant = Other

(3) Provide in Column (3), the date(s) when the evaluation will be conducted including the date for completion of reports.
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FORMAL THIRD-PARTY EVALUATION FORM (A formal evaluation conducted by a party not employed by the fiscal agent

either under contract with the project recipient or under the auspices of the DOE.)

(1) Scope of Evaluation and Brief Description

(2) Type of Entity Conducting Evaluation

(3) Date(s) Evaluation
to Be Conducted
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FLORIDA DEPARTMENT OF EDUCATION | A7 Number

#08C122
PROJECT APPLICATION
Please return to: A) Program Name: DOE USE ONLY
Florida Department of Education Interdistrict Agreements for Expanding School Date Received

Office of Grants Management
Room Turlington Building
325 West Gaines Street
Tallahassee, Florida 32399-0400
Telephone: (850)

Suncom:

Choice through Voluntary Public School Choice
(VPSC) Models

B) Name and Address of Eligible Applicant: Project Number (DOE Assigned)

) D)
C)  Total Funds Requested: Applicant Contact Information
$ Contact Name: Mailing Address:
DOE USE ONLY Telephone Number: SunCom Number:
Total Approved Project:
$ Fax Number: E-mail Address:

CERTIFICATION

I, , (Please Type Name) do hereby certify that all
facts, figures, and representations made in this application are true, correct, and consistent with the statement
of general assurances and specific programmatic assurances for this project. Furthermore, all applicable
statutes, regulations, and procedures; administrative and programmatic requirements; and procedures for
fiscal control and maintenance of records will be implemented to ensure proper accountability for the
expenditure of funds on this project. All records necessary to substantiate these requirements will be
available for review by appropriate state and federal staff. | further certify that all expenditures will be
obligated on or after the effective date and prior to the termination date of the project. Disbursements will be
reported only as appropriate to this project, and will not be used for matching funds on this or any special
project, where prohibited.

Further, 1 understand that it is the responsibility of the agency head to obtain from its governing body the
authorization for the submission of this application.

E)

Signature of Agency Head

DOE 100A
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Instructions for Completion of DOE 100A

A. If not pre-printed, enter name of the program for which funds are requested.

B. Enter name and mailing address of eligible applicant. The applicant is the public or non-public
entity receiving funds to carry out the purpose of the project.

C. Enter the total amount of funds requested for this project.

D. Enter requested information for the applicant’s contact person. This is the person responsible for
responding to all questions regarding information included in this application.

E. The original signature of the appropriate agency head is required. The agency head is the
school district superintendent, university or community college president, state agency
commissioner or secretary, or the president/chairman of the Board for other eligible applicants.

e Note: Applications signed by officials other than the appropriate agency head identified above
must have a letter signed by the agency head, or documentation citing action of the governing body
delegating authority to the person to sign on behalf of said official. Attach the letter or
documentation to the DOE 100A when the application is submitted.

DOE 100A
Revised 12/07 Page 31 Dr. Eric J. Smith, Commissioner



A)

Name of Eligible Recipient:

TAPS Number

B) #08C122
Project Number: (DOE USE ONLY)
FLORIDA DEPARTMENT OF EDUCATION
BUDGET NARRATIVE FORM
(4)
(1) 2) (3) FTE (5)
FUNCTION | OBJECT ACCOUNT TITLE AND NARRATIVE POSITION AMOUNT
C) TOTAL | $

DOE 100A

Revised 12/07

Page 32

Dr. Eric J. Smith, Commissioner




Instructions
Budget Narrative Form

This form should be completed based on the instructions outlined below, unless instructed otherwise in the Request
for Proposal (RFP) or Request for Application (RFA).

A. Enter Name of Eligible Recipient.

B. (DOE USE ONLY)
CoLumN 1

FUNCTION: ScHOOL DISTRICTS ONLY:
Use the four digit function codes as required in the Financial and Program Cost Accounting
and Reporting for Florida Schools Manual.

COLUMN 2

OBJECT. ScHoOOL DISTRICTS:
Use the three digit object codes as required in the Financial and Program Cost Accounting
and Reporting for Florida Schools Manual.

COMMUNITY COLLEGES:
Use the first three digits of the object codes listed in the Accounting Manual for Florida’'s
Public Community Colleges.

UNIVERSITIES AND STATE AGENCIES:

Use the first three digits of the object codes listed in the Florida Accounting Information
Resource Manual.

OTHER AGENCIES:
Use the object codes as required in the agency’s expenditure chart of accounts.

COLUMN 3- ALL APPLICANTS:

ACCOUNT TITLE: Use the account title that applies to the object code listed in accordance with the
agency's accounting system.

NARRATIVE:

Provide a detailed narrative for each object code listed. For example:

e SALARIES - describe the type(s) of positions requested. Use a separate line to describe each type
of position.

e OTHER PERSONAL SERVICES — describe the type of service(s) and an estimated number of hours for
each type of position. OPS is defined as compensation paid to persons, including substitute
teachers not under contract, who are employed to provide temporary services to the program.

DOE 100A
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e PROFESSIONAL/TECHNICAL SERVICES - describe services rendered by personnel, other than agency
personnel employees, who provide specialized skills and knowledge.

e CONTRACTUAL SERVICES AND/OR INTER-AGENCY AGREEMENTS - provide the agency name and
description of the service(s) to be rendered.

e TRAVEL - provide a description of each type of travel to be supported with project funds, such as
conference(s), in district or out of district, and out of state. Do not list individual names. List
individual position(s) when travel funds are being requested to perform necessary activities.

e CAPITAL OUTLAY - provide the type of items/equipment to be purchased with project funds.

e INDIRECT COST - provide the percentage rate being used. Use the current approved rate.
(Reference the DOE Green Book for additional guidance regarding indirect cost.)

COLUMN 4 — MUST BE COMPLETED FOR ALL SALARIES AND OTHER PERSONAL SERVICES.
FTE - Indicate the Full Time Equivalent (FTE based on the standard workweek for the type of
position) number of positions to be funded. Determine FTE by dividing the standard number of
weekly hours (e.g., 35 hours) for the type of position (e.g., teacher aide) into the actual work hours
to be funded by the project.

COLUMN 5
AMOUNT - Provide the budget amount requested for each object code.

C. TOTAL - Provide the total for Column (5) on the last page. Must be the same amount as
requested on the DOE-100A.

DOE 100A
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